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DISCLAIMER

THERE  ARE  NO  WARRENTIES  TO  YOU  OR  ANY OTHER  PERSON  OR  ENTITY FOR  THE  PRODUCT EXPRESSED  OR
IMPLIED.   INCLUDING BUT NOT LIMITED TO IMPLIED WARRENTIES  OF MERCHANTABILITY AND FITNESS FOR A
PARTICULAR PURPOSE.  ALL SUCH WARRENTIES ARE EXPRESSLY AND SPECIFICALLY DISCLAIMED.  IN NO EVENT
SHALL ERIC HUFFMAN BE RESPONSIBLE FOR INCIDENTAL OR CONSEQUENTIAL DAMAGES,  INCLUDING BUT NOT
LIMITED TO LOSS OF USE, LOSS OF DATA, OR LOSS OF PROFITS, EVEN IF ERIC HUFFMAN HAS BEEN ADVISED OF THE
POSSIBILITY OF SUCH DAMAGES.

Apple and Macintosh are registered trademarks of Apple Computer, Inc.  
Finder and MultiFinder are trademarks of Apple Computer, Inc.
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1 - Introduction

What is Megalomania?

Megalomania (noun) 1 : a mania for great or grandiose performance  2 : a delusional mental disorder that is
marked by infantile feelings of personal omnipotence and grandeur

Megalomania is a Macintosh application that turns your MIDI system into a unique tool for performance 
and composition.

Megalomania is a real-time processor of MIDI data.  The processing that takes place is designed by the user
via an icon-based interface.  The user designs a process by connecting together icons.  Each icon represents 
a simple computation (delay, transposition, etc...) and the connections represent the flow of MIDI data.  

Megalomania is like a MIDI effects box for your MIDI system.  Since the processing that occurs is 
configurable, the program is in some ways a MIDI analog to multi-effects processors in the audio domain.

What You Need

• A Macintosh Plus, or later model.

• A MIDI interface attached to the modem or printer port.

• At least one MIDI-compatible synthesizer attached to the MIDI interface.

• Your Macintosh should be running with System 6.0, or later.

2 - Test Drive

It is presumed that you have the required hardware and are running the Macintosh with System 6.0, or later.
Start the application up by double-clicking on the application icon from the Finder.

Setting Up the MIDI Port

The first time you use the program you should select the Setup MIDI... command from the Edit menu.  
The Setup MIDI dialogue box will allow you to select the port to which your interface is attached.

What is Here

When the application starts it presents an untitled window within which the design of a process occurs.  
This is a Sketch Pad window.  Left of the Sketch Pad window is the Tools palette and the Play window.
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Installing Midi In and Midi Out

Each process needs Midi In and Midi Out modules.  First, click on the Install tool in the Tools palette.

Second, select the Midi In item in the Fx menu.  Third, click once in the Sketch Pad window.  An icon 
should appear that resembles a small keyboard.

Forth, select the Midi Out item in the Fx menu.  Fifth, click once in the Sketch Pad window.  Now there 
should also be an icon that resembles a MIDI plug.

The Midi In module is the source for all MIDI data.  All the MIDI data which comes into the computer via 
the MIDI interface is accessed in the Sketch Pad window via the Midi In module.  The Midi Out module is 
the terminus for all processing that takes place in the Sketch Pad window.  Data sent to the Midi Out goes 
out of the computer via the MIDI interface.
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Now, add one more module.  First, select the Note Transpose item in the Fx menu.  Second, click once in 
the Sketch Pad window.  Now there should be an icon that resembles two notes separated by an interval.
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Wiring Modules

To make these modules work they need to be wired together.  First, click on the Wire tool in the Tools 
palette.

Second, click once on the Midi In icon and drag a wire onto the Note Transpose icon.  Third, click once on 
the Note Transpose icon and drag a wire onto the Midi Out icon.  Things should look sort of like this:

This process sends MIDI input to the Note Transpose module, which sends it's output to the Midi Out 
module, which sends the MIDI data to the MIDI interface.  So, this process simply transposes all notes by 
some interval.

Adjusting Parameters

To adjust the parameters associated with the Note Transpose module, or any other module, double-click on 
the icon with the Arrow tool.  First, click on the Arrow tool in the Tools palette.
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Second, double-click on the Note Transpose icon.  The parameter window for the module will open.  This 
window has two controls which allow the transposition interval to be adjusted.  The two controls are Value 
controls and are adjusted by clicking in the upper or lower portion of the control.  Clicking and holding in 
the upper portion control will cause the values to increase in value.  Clicking and holding in the lower 
portion control will cause the values to decrease in value.  The cursor will change into a arrow 
appropriately pointing upward or downward.

MIDI input can be used to set values as well.  If the Use MIDI Value command in the Special menu is 
selected then MIDI input into the module will set the value of the selected control.  To turn this option off, 
unselect the Use MIDI Value command.  If you want to stop MIDI input from changing the value of the 
selected control then just click someplace else within the window to unselect the control.

Keyboard entry can be used to set values as well.  When you cmd-click on a Value control (clicking with 
the command key held down) then a small dialog pops up, enabling you to type in the value desired.

Start Processing

The application will actually start processing when the Start button in the Play window is pressed.  Press 
this button and doodle with your MIDI controller.  

You should find that all the notes that go through the Macintosh are transposed by the interval set by the 
Note Transpose module.

Adding More Modules

To make things more interesting you might want to add a Delay module.  First, select the Install tool in the 
Tools palette.  Second, select the Delay item in the Fx menu.  Third, click once in the Sketch Pad window.  
Now there should be a new icon that represents delayed notes.

Now, the Midi In module will be disconnected from the Note Transpose module.  First, select the Scissors 
tool from the Tools Palette.  Second, click once at some point on the wire that connects the Midi In icon to 
the Note Transpose icon.  The wire will vanish once it has been cut.
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Now, use the Wire tool to connect the icons as in the following:

To adjust the parameters of the Delay module double-click on the Delay icon with the Arrow tool.  The
Parameter window for the Delay module will open.

Again, values can be adjusted by clicking in the upper or lower portion of the Value control.  The Delay 
module delays MIDI data by a percentage of a beat (the tempo is set in the Play window).  The velocity of a
note is decreased for each delay.  Pitch bend, channel pressure, and controls will also be delayed if the 
appropriate check boxes are checked.

Again, processing will not begin until the Play button is pressed.  Press the Play button and doodle with 
your MIDI controller.

You should find that all the notes going into the Macintosh are delayed and transposed according to the 
parameters you have set in the parameter windows for the Delay module and the Note Transpose module.

At this point it may be a good idea to experiment with some of the examples that come with Megalomania.

Caveats

As with signal processors in the audio domain, many simultaneous effects will load a CPU down.  It is very
easy to create Megalomania processes that will tax the Macintosh CPU to the extent that you will probably 
hear latencies and various hiccups.  To some extent this can be avoided.  If you imagine each module as a 
little computer you can begin to picture hot spots in your design.  

For instance, in the last example the Note Transpose module is positioned after the Delay module.  This 
means that multiple copies of each note are created and each copy must be transposed before it 
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is played.  It would be more efficient to transpose the incoming note first, and then send it to the Delay 
module, where multiple copies would be made of the already transposed note.

Essentially, it is a good idea to keep as much processing as you can before delays and branches.

3 - Sketch Pad Window

The Sketch Pad window is the place where you design a process, or MIDI effect.

A new Sketch Pad is created when you select the New command from the File menu.  The contents of this 
window may be saved and retrieved to and from disk via the Open..., Save, and Save As... commands in 
the File menu.  The Close command from that menu will close the window, after asking you if you wish to 
save your material, if appropriate.

The Tools palette and Edit menu are used to manipulate modules in the Sketch Pad window (see Tools 
Palette and Edit Menu sections).  Associated with each Sketch Pad are four Note Maps (see Note Map 
section).  These are edited via the Note Map... command in the Special menu (see Special Menu section).

Several Sketch Pad windows may be open at the time.  Also, the current Sketch Pad (the front window) 
may be switched during processing.  So, the nature of the processing can be changed during performance 
simply by selecting a new Sketch Pad window.

4 - Tools Palette

The Tools palette allows you to select cursor tools with which you can manipulate modules in the Sketch 
Pad window.  A tool is selected by clicking on it with the mouse.  

Install Wire 

Scissors Arrow 

Install Tool

When the Install tool is selected the cursor changes into a hand when positioned over a Sketch Pad 
window.  When the mouse is clicked in a Sketch Pad window with the Install tool a new module will be 
installed and it's icon will appear in the window.  The module that is installed is determined by the currently
checked item in the Fx menu.

The Install tool is automatically chosen when you select an item in the Fx menu.

Wire Tool

When the Wire tool is selected the cursor changes into a cross when positioned over a Sketch Pad window. 
Two modules are wired together by clicking on the icon of one module and dragging a wire over to the icon
of another module.
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Scissors Tool

When the Scissors tool is selected the cursor changes into scissors when positioned over a Sketch Pad 
window.  The wire connecting two modules can be severed by clicking on the wire with the scissors cursor.

Arrow Tool

When the Arrow tool is selected the cursor changes into an arrow when positioned over a Sketch Pad 
window.  Clicking on an icon in a Sketch Pad window will Select the module.  When a module is selected 
it can be cut by selecting the Cut command from the Edit menu (sorry, the module can not be copied, 
pasted, or duplicated) (see Edit Menu section ).  

The icon can be given a name when it is selected.  This is done be selecting the Fx Name… command in 
the Edit menu.  A dialog will pop up, enabling you enter in a name for the icon.  This name will then appear
in the Sketch Pad and will define the name of that modules parameter window.

Also with the Arrow tool, clicking on an icon and dragging will reposition the icon.  And, double-clicking 
on an icon will open the parameter window for that module.

5 - Play Window

The Play window controls several global aspects of processing.

MIDI File playback 

Stop processing 

Start processing

Record processing 

Tempo 

MIDI File playback

A MIDI File will be merged with input from the MIDI interface when the MIDI File button has been 
pushed.  First, a MIDI File has to be imported.  To import a MIDI File select the Import Midi File... 
command from the File menu.

If a MIDI File has not been imported and the MIDI File button is pushed it will not remain selected.  This 
indicates that there is no MIDI File to playback.  When a MIDI File has been 
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imported the MIDI File Button will remain selected when pushed.  This indicates that the MIDI File will be
merged with input from the MIDI interface when the application begins processing.

The MIDI File may be looped during playback, that is, when the end of the file is reached it will begin 
playing from the beginning again.  This option may be enabled by selecting the Loop MIDI File command 
in the Special menu.

Stop Processing

When the Stop button is pushed the application will halt processing.  If the modules are still processing 
MIDI data when the Stop button is pressed the button will remain selected and the cursor will change into a
spinning clock.  When the modules are finished the regular cursor will appear and the Stop button will no 
longer be selected.

This behavior is desirable when you want delay buffers to flush out before actually stopping.

If the application is in this flushing state you can force it to stop, or kill the flush, by pressing the space bar.

When the application is processing, before a halt, pressing the space bar will trigger the Stop button.

Start Processing

When the Start button is pushed the application will begin processing.  The Start button can also be 
triggered by pressing the space bar when the application is not processing.

Record Processing

The processed MIDI data can be recorded and saved as a MIDI File.  When the Record button is pushed all
Record modules will record the MIDI data that they receive through the wires (see Midi Record section).

This recording can be saved to disk as a MIDI File by selecting the Export Midi File... command from the 
File menu.

Pressing the Enter key will trigger the Record button.

Tempo

This Value control adjusts the global tempo of the processing.  This value is used to determine parameters 
for processing in the time domain, such as delay, and for controlling the playback of a MIDI File. 

6 - Memory Window

This window shows you how much memory you have left.  It is like a fuel gauge, you start out full and 
slide towards empty as the number of your processing modules increase.

7 - Module Controls

Apart from the standard Macintosh controls there are two controls which are used extensively in the 
parameter windows for the modules.  These are the Value control and Graph control.
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Value Control

The Value control is a rectangle with either a numerical or note value within it.  The value is adjusted by 
clicking in the upper or lower portion of the control.  The cursor will change into an arrow pointing 
upwards or downwards, indicating the direction in which the value is being scrolled.

MIDI input can be used to set values as well.  If the Use MIDI Value command in the Special menu is 
selected then MIDI input into the module will set the value the control when it is selected.  To turn this 
option off, unselect the Use MIDI Value command.  If you want to stop MIDI input from changing the 
value of the selected control then just click someplace else within the window to unselect the control.

Keyboard entry can be used to set values as well.  When you cmd-click on a Value control (clicking with 
the command key held down) then a small dialog pops up, enabling you to type in the value desired.

Graph Control

Graph controls are like low frequency oscillators that are attached to parameters in the various parameter 
windows.  You can define the shape of the waveform and the period for this low frequency oscillator.  But, 
it does more.  A MIDI control can override the waveform and provide it's own values instead.  This gives 
you real-time control over parameters via MIDI.

When a Value control has a Graph button attached to the right, this indicates that a Graph control is present.

Clicking on the Graph button will open the Graph window.

This, for instance is the Graph window for the target note in the Note Transpose parameter window.  The 
two numbers at the bottom show you the period of the Graph in percentage of a beat, right now the period 
is a beat long.  The period is set by adjusting the Value control at the 
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bottom of the window.  Adjusting the two numbers at the right change the view of the waveform but do not 
actually change the waveform.

This example shows two views on the same waveform.  The graph actually modulates the parameter it is 
attached to when the Graph Active box is checked.  You will not actually see values change on the screen 
(as this takes up too much processing time) but inside the module the values are changing.

If the Use Control box is checked then the waveform is overridden by the last value of the specified 
control.  This value is scaled to the values which describe the view of the waveform.

In this example, control number 5 on channel 10 is being used to modulate the target note.  Incoming 
control values can range from 1-128 but here they are scaled to range from 11-54.

IMPORTANT NOTE ABOUT GRAPHS:

Since Graphs vary parameters over time it is possible to misalign note off commands with respect to their 
associated note on commands.  For instance, the target note in the Transpose Note module may be varied 
with a Graph.  If the transposition changes between a note on & off then the note will hang.  There is no 
book keeping to prevent this since it is computational expensive.  
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Hanging notes can be prevented by placing a Duration Assign module at the output of any module that may
misalign note ons & offs via the use of a graph.  This will force an aligned note-off to occur.
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8 - The Modules

Midi In

Midi In icon 

The Midi In module is the source of all MIDI data for a Sketch Pad window.  There can only be one Midi 
In module per Sketch Pad window.

The Midi In module allows Pitch Bend, Channel Pressure and Controls to be filtered out.  Processing 
continuous controls demands a lot of the CPU (see Caveats section).  So, if you do not need to deal with 
some of the continuous control data, it  is desirable to remove that data.

Incoming data can be patched directly to a MIDI channel via the twelve check boxes at the bottom of the 
parameter window.

Midi Out

Midi Out icon 

The Midi Out module is a sink for all MIDI data.  All data sent to the Midi Out module is sent to the MIDI 
interface attached to the Macintosh.

Table of Contents - 17



Table of Contents
Midi Record

Midi Record icon 

The Midi Record module is a sink for all MIDI data.  All data sent to the Midi Record module is recorded 
when the Record button is pressed.  This recording may then be saved as a MIDI File (see Play Window 
section).

The recording functionality is separated from the Midi Out module.  This is useful when you want to 
record a subset of all the material actually being sent to the MIDI interface.  For instance, you might import
a click track as a MIDI File, and practice playing along with it.  When you record, you may want to record 
your playing but not the click track.  The click track can be separated with any of the filtering modules and 
sent to a Midi Out module but not to a Midi Record module.  Your playing can be separated with any of the 
filtering modules and sent to a Midi Out module and a Midi Record module.  

Delay

Delay icon 

The Delay module creates a MIDI delay.  The MIDI data is delayed by a percentage of a beat, where the 
tempo is determined by the setting in the Play window.  The number of repetitions can be set with a Value 
control.  For note on data the velocity can be decremented upon each repetition.  This can be set with a 
Value control.

Normally, only note data is delayed and all other data is ignored.  But, continuous controls can also be 
delayed by checking the appropriate boxes.  The decay amount has meaning only with respect to note on 
data. 
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Duration Assign

Duration Assign icon 

The Duration Assign module sets the duration of notes.  This means that for each note on the module 
receives it will create a note off at a time determined by the duration value.  This value may be adjusted 
with a Value control.  The duration is specified as a percentage of a beat, where the tempo is determined by 
the setting in the Play window.

All other data is passed without change.

Note Filter

Note Filter icon 

The Note Filter module removes note on and note off data meeting certain criteria.  All other data is always
passed.

If the Pass box is checked then notes with either odd values or even values are passed through the module.  
If the Pass notes box is checked then notes within the specified range are passed through the module.  If 
both boxes are checked then notes that meet both criteria are passed through the module.

If the Remove note off box is checked then all note off data is removed.  This is useful when you have the 
Duration Assign module set at the end of a processing chain.  Since the duration will be assigned it is not 
necessary to process note off data before that module.  So, you can remove note off data at the beginning of
the chain, and thus not burden the rest of the processing chain with that data.  And, CPU time will be used 
more efficiently.
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Note Filter {Single}

The Note Filter {Single} module  serves a single purpose.  It only passes note information for the single 
note specified.

Note Transpose

Note Transpose icon 

The Note Transpose module transposes all note data by the interval described by the two values in the 
parameter window.  All other data is passed without change.

Note Map

Note Map icon 

The Note Map module uses the four Note Maps associated with the Sketch Pad window.  Each note map 
associates each of the twelve pitches in the octave with a pitch in the same, lower, or upper octave.  

The Note Maps for a Sketch Pad window are edited by selecting the Note Map... command from the 
Special menu.  This command presents a dialogue box with which the maps can be adjusted.
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In this example Note Map 1 maps all notes to accidentals.  Note Map 2 maps notes to different octaves 
sometimes.  Note Maps 3 and 4 do nothing.

All note data is adjusted according to the Note Map selected in the parameter window.  All other data is 
passed without change.

Note Hold

Note Hold icon 

The Note Hold module selectively delays the passage of note off data.  This creates chords with n pitches, 
where n is the adjustable value in the parameter window.  This is done by always leaving n notes hanging.  
After n notes are hanging the entry of a new note into the module will turn off the oldest hanging note.

All other data is passed without change.
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Note Cluster

Note Cluster Icon

The Note Cluster module is similar to the Delay module.  Note on and note off information is delayed.  

The initial delay is set by the Delay Time control.  Again, all delay times are expressed as a percentage of a 
beat.  After the first delay each following delay is longer or shorter.  This is determined by the Delay Inc. 
control.  For example, with an initial delay of 50% and an incremental change of 25% the delay times 
would increase: 50%, 75%, 100%, 125%, etc…  

The initial change in velocity for each delay is set with the Decay Amount control.  After the first delay 
each following delay has a greater or smaller change in velocity.  This is determined by the Decay Inc. 
control.  For example, with an initial decay of 5 velocity values and an incremental change of 1 the decay 
values would increase: 5, 6, 7, 8, etc…  

The number of delays is set by the Number of Delays control.  This control can be assigned to a graph, 
allowing the number of delays to change over time or be adjusted by MIDI controllers.

Only note on and note off data is delayed, all other data is ignored.

Velocity Filter

Velocity Filter icon 

The Velocity Filter module removes note on and note off data meeting certain criteria.  All other data is 
always passed.
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If the Pass velocity with box is checked then notes with either odd velocities or even velocities are passed 
through the module.  If the Pass velocity box is checked then notes with velocities within the specified 
range are passed through the module.  If both boxes are checked then notes that meet both criteria are 
passed through the module.

Velocity assign

Velocity Assign icon 

The Velocity assign module changes the velocity of note on data.  The velocity may be set to a constant 
value or may be changed by a percentage.  All other data is passed without change.

Channel Filter

Channel Filter icon 

The Channel Filter module selectively passes data on the selected channel.  The channel is selected by 
adjusting the Value control and the type of data is selected by checking the appropriate boxes.
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Channel Assign

Channel Assign icon 

The Channel Assign module assigns data to the selected channel.  The channel is selected by adjusting the 
Value control and the type of data is selected by checking the appropriate boxes.

Channel Hocket

Channel Hocket icon 

The Channel Hocket module changes the channel of note on and note off data.  This module hockets notes 
through selected channels.  For example, if channels 1, 3, and 5 are checked then the first note entering the 
module would be assigned to channel 1, the second note to channel 3, the third note to channel 5, the forth 
note to channel 1, and so on.  The module assigns note off data to the correct channel, i.e., note off data 
follows note on data on the channel that it was assigned to.

All other data is not passed through this module.
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Program Change

Program Change icon 

The Program Change module allows one-to-one program change mappings.  When an incoming program 
change meets the criteria (program change number and channel) a program change is sent with the selected 
parameters (again,  program change number and channel).  The original program change is not passed.  All 
other data is passed without change.

Control Map

Control Map icon 

The Control Map module allows one-to-one continuous control mappings.  When an incoming continuous 
control meets the criteria (pitch bend, channel pressure, or control number) a continuous control is sent 
with the selected parameters (again,  pitch bend, channel pressure, or control number).  The original 
continuous control is not passed.  All other data is passed without change.
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Control Map

Control Envelope icon

The Control Envelope module generates controller data over time as described by the graph in it's 
parameter window.  The controllers number and channel may be set.  The duration of the envelope is set by 
the rightmost control at the bottom of the graph.  Like all graphs, the view of the data can be changed by 
adjusting the controls along the right edge of the graph.

The data is generated by incoming note on and/or note off data.  The controller data can be altered by the 
note data.  If the controller data is scaled by note velocity then the amplitude of the envelope will be at it's 
maximum when the note velocity is at its maximum.  For example, when the velocity is 128 then the 
controller data is unchanged and when the velocity is 64 then the controller data is scaled by 50%.  If the 
controller data is scaled by note value then the amplitude of the envelope will be at it's maximum when the 
note value is at its maximum.  For example, when the note value is G#8 then the controller data is 
unchanged and when the value is E3 then the controller data is scaled by 50%.

9 - Menus

File Menu

New
Open...
Close
-
Save
Save As...
-
Import Midi File...
Export Midi File...
-
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Transfer...
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Quit

New  - Creates a new Sketch Pad window.

Open - Opens a Sketch Pad window that has been saved to disk.

Close - Closes the front Sketch Pad window.

Save - Saves the front Sketch Pad window.

Save As - Saves the front Sketch Pad window.

Import Midi File - Imports a MIDI File that has been saved to disk, this application supports version 1.0 of 
the MIDI File specification.  This MIDI File can be merged with input from the MIDI interface by selecting
the MIDI File button in the Play window.

Export Midi File - The MIDI data which is recorded with the Midi Record module can be saved as a MIDI 
File.

Transfer - Allows you to exit to another program without going to the Finder first.

Quit - Bye.

Edit Menu

Undo
-
Cut
Copy
Paste
Clear
Duplicate
-
Setup Midi...
Fx Name…

The Cut, Copy, Paste, Clear, and Duplicate commands all apply to modules in the Sketch Pad window.

Setup Midi.... - Allows you to choose the port for MIDI transmission.

Fx Name… - Allows you to assign a name to an icon.  This name appears in the Sketch Pad window and is 
the title of the associated parameter window.

Fx Menu

When the Install tool is clicked in a Sketch Pad window the module that is currently checked in this menu 
will be installed.  Selecting an item in this menu automatically selects the Install tool.

See the module section of this manual for a full description of module operation.

Special Menu

Note Map...
Clean Up Icons
Use MIDI Value
Sys-Ex thru
Loop MIDI file
Receive Sync
All Notes Off
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Note Map... - Opens the note map editor for the front Sketch Pad window.

Clean Up Icons - Nudges all icons to a predefined grid in the Sketch Pad Window.

Use MIDI value - When this option is selected Value controls in parameter windows can be set by MIDI 
data entering the module.  This only applies to controls which are selected in windows that are the 
frontmost window.  When a control has been set to the desired value you can deselect the control by 
clicking elsewhere in the parameter window.

Sys-Ex thru - When this option is selected system-exclusive data is passed through the MIDI port unaltered 
when the Play button is engaged.

Loop MIDI file - When this option is selected the MIDI File is looped during playback, that is, when the 
end of the MIDI File is reached playback will begin from the beginning again.

Receive Sync - When this option is selected incoming MIDI beat clocks will set the global tempo for 
Megalomania processing.

All Notes Off - Kills the processing in the front window, sends an all notes off message and sends note off 
data for each note on all channels, restarts processing.

Window Menu

This menu lists all open Sketch Pad windows.  Selecting an item in the menu will bring the chosen Sketch 
Pad window to the front.

10 - MIDI Manager™

Megalomania supports Apple's MIDI Manager.  MIDI Manager provides the following advantage.  You can
run more than one MIDI program simultaneously in MultiFinder, passing data back and forth between 
MIDI programs.

A disadvantage if that MIDI Manager can tax the processing power of your Macintosh.  If you have a 
Macintosh Plus or Macintosh SE, you may find that intensive Megalomania processing will cause timing to
become sluggish.

To benefit from the use of MIDI Manager you need another MIDI program that is compatible with it.  The 
files needed to install MIDI Manager are not provided with Megalomania.  Please consult your other MIDI 
programs documentation to install MIDI Manager.

Once MIDI Manger has been installed, start up Megalomania and make sure that the MIDI Manager option
is set in the Setup MIDI… dialog.  To view Megalomania's MIDI Manager configuration, open the 
PatchBay™ desk accessory or application.  When you open PatchBay, you will see something like this after
starting up Megalomania.
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Connections between Megalomania and other programs are made by wiring together their respective input 
and output ports.
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all notes off 24
Arrow tool 4, 8
Channel Assign module 20
Channel Filter module 19
Channel Hocket module 20
Channel Pressure 13
connecting two modules 8
Control Envelope module 22
Control Map module 21
Controls 13
current Sketch Pad 7
Delay module 5, 14
Duration Assign module 15
Edit menu 2
Enter key 9
exit 23
flushing state 9
Fx menu 3, 7
Fx Name… 8
global tempo 9
Graph control 9
Install tool 3, 7
Keyboard entry 5, 10
latencies 6
Loop MIDI File 9
low frequency oscillators 10
memory 9
MIDI delay 14
MIDI File 8, 23
MIDI File button 8
Midi In 3
Midi In module 13
MIDI interface 13
Midi Out 3

Midi Out module 13
Midi Record module 14
Note Cluster module 18
Note Filter module 15
Note Filter {Single} module 16
Note Hold module 17
note map editor 24
Note Map module 16
Note Transpose 3
Note Transpose module 16
parameter window 5, 6, 8
Pitch Bend 13
Play window 2, 8
Program Change module 21
Record button 9, 14
Record modules 9
Scissors tool 5, 8
Setup MIDI... 2
simultaneous effects 6
Sketch Pad 7
Sketch Pad window 2
space bar 9
Start button 5, 9
Stop button 9
system-exclusive 24
Tempo 9
Tools palette 2, 7
Use MIDI Value 5, 10
Value control 9, 10
Value controls 5
Velocity assign module 19
Velocity Filter module 18
Wire tool 4, 7
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